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In this Release
This Readme document contains release notes for Lite-Configurator Version 2.5. It includes
installation information as well as instructions for getting started with the program and version
history.
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Installation
Your System
To install and run this program, your system will need the following:







Microsoft 2000 with Service Pack 2, Windows XP with SP2, Windows Vista, or
Windows 7.
Microsoft Office 2000 or higher
Administrative privileges on the system
Microsoft Internet Explorer 6 or higher
Super VGA monitor with a screen resolution set to at least 1024 x 758, small fonts
256 MB of RAM (1 GB of RAM for Windows Vista and Windows 7)

Installation Notes:
Microsoft Vista and Windows 7 Users – If you are using Microsoft Vista or Windows 7 and you
are having problems running the program you can try using the “Run as Administrator” option.
1) Locate the applications icon or short cut and Right click on it.
2) From the popup menu select properties and then select the Compatibility Tab.
3) Under Privilege Level, select “Run this program as an administrator”, and then click OK.
Microsoft Components –This program requires that you have certain Microsoft system
components installed on your system. The setup will check your system for these components,
and if not on your system, will automatically install them.
Known issue with Microsoft Access – Access 2003 may not start as expected after you install
Office 2003 SP2 or any program–such as Lite-Configurator–that installs Microsoft data objects.
You may receive a message similar to the following:

Please wait while Windows configures Microsoft Office Professional Edition 2003
The configuration appears to finish as expected, but Access 2003 does not start. When you try to
start Access 2003 again, you receive the same message. For instructions on fixing this, go to:
http://support.microsoft.com/kb/914830/en-us.
Reboot – If Windows prompts you to reboot your system, do so or Lite-Configurator may not run
properly.
Uninstalling the program – Select Lite-Configurator from the Windows Control Panel
Add/Remove Programs feature in Windows 2000 and XP and in Programs and Features in
Windows Vista and Windows 7.

Additional Software – Adobe Acrobat Reader
Viewing data sheets from within the program requires Adobe Acrobat Reader. If you do not have
Adobe Acrobat Reader installed, you can install it by downloading the latest release at
http://www.adobe.com.

Version History
Version 2.5 (Web Download – May 31, 2013):

















Removed the following accessories from the CHG series battery chargers: AM-1F, VM-1F,
MPM-3F.
Corrected the link to the MS-25 and MS-9200UDLS data sheet.
Fixed a bug that would cause the program to crash when canceling changing circuit options
for Intelligent Control Panels.
Added seismic kits for all control panels, power supplies, and batteries.
Updated current draws for the MS-9600LS and MS-9600UDLS Main Circuit Board current.
Also updated current draw for the DACT-UD2.
Corrected a bug on the Bill of Materials screen that would cause the program to crash when
resizing the program.
Added the ECC-50/100 Emergency Command Center to the program for use with compatible
Fire Alarm Control Panels.
Added the ability to build a standalone voice system configuration using the ECC-50/100.
Corrected a bug that would cause the incorrect current draw to be subtracted from a power
source when moving Notification appliances from one power source to another.
Corrected a bug that would cause incorrect current draw changes to be applied to NonResettable circuits when moving devices back and forth between NAC circuits added with the
CMF-300 Intelligent Module.
Added price fields to the Excel export spreadsheet so users will be able to add their pricing
information to create a quote for the system.
Corrected a problem with printing data sheets from the Bill of Materials screen if users had
Adobe Acrobat or Adobe Reader version 10 or greater installed.
Moved the following parts from the Panel Modules circuit to Non-Resettable circuits: 411,
411UD, IPDACT-2, and IPDACT-2UD.
Added an ECC-50/100 Voice Wizard to the program. Users will now be able to configure an
ECC system with a Firelite control panel or a standalone system. The Voice Wizard can be
launched from the Voice tab on the Lite-Configurator Projects screen.
Corrected a run time error (Run time error 1004: Select method of worksheet class
failed) that would sometimes occur when launching the Excel battery calculations.
Replaced the old IPGSM-DP with the new IPGSM-4G.




Corrected some miscellaneous spelling errors in the program.
The Report export feature has been streamlined with non-working and irrelevant export
formats removed. Users can now export to the following formats: PDF, Comma Separated
Values (CSV), HTML, Rich Text file (RTF), and Standard Text (TXT).

Version 2.4.2 (Online Update – April 4, 2012):








Corrected a division by zero error that would occur while attempting to delete intelligent
modules like the MMF-300 and MMF-301.
Removed extraneous columns inside the input grid of the Delete Circuit dialog box.
Locked the quantity field for the following parts when editing them (note: this was done
primarily to intelligent devices that add additional circuits to the configuration):
o MDF-300, MMF-300, MMF-300-10, and MMF-301
The MDF-300 will now correctly add two Initiating Device Circuits for Dry Contact devices to
the circuit grid per module.
The following parts have been correctly classified as dry contact devices to enable them to be
added to dry contact circuits.
o BG-12LR, BG-12LRA, BG-8, XAL-53, and PIBVEXP.
Corrected a bug that would cause random run time errors and current draw discrepancies
when moving NAC devices between standard NAC circuits and NAC circuits that were added
to the configuration with a CMF-300 or CMF-300-6.
Added the CDRM-300 to the database for use in all applicable control panels. The CDRM300 will add two circuits for adding Dry Contact devices to the configuration.

Version 2.4.1 (Web Download) – December 15, 2011



Corrected a problem when trying to edit Speakers and Strobes, the program would give an
error then lock up. This has been corrected.
Fixed a run time error users would get when trying to update Lite-Configurator: Run time error
5, Invalid procedure call or argument.

Version 2.4 (Web download) – November 30, 2011
New Features









Added a Reset Grid Format button to the circuit configuration grid. Click to go back to the
default grid.
Added mouse wheel button scrolling for the circuit grid on the Configuration page and Bill of
Materials page.
Added Resettable and Non-Resettable circuits to the circuit level detail on the battery
calculation sheets for applicable control panels.
Added the IPGSM-DP and accessories to the database.
Added CHG-75 and CHG-120F accessories: AM-1F, VM-1F, and MPM-3F (CHG-120F only).
Added the IPDACT-2 and IPDACT-2UD for the MS-25. Note: You cannot mount the IPDACT2/UD inside the MS-25 cabinet therefore the IPBRKT is not a selectable option. The IPDACT2/UD must be mounted in the IPENC enclosure or in the HP300ULX.
Export the circuit grid (power source, circuit, part, and accessory information) to Excel. Press
the Export Circuit Grid to Excel button on the Configuration page. From the File menu select
Export -> Circuit Grid.
Added additional error checking when changing circuit configurations for control panels,
deleting parts that add additional circuits to the configuration, and for removing power




supplies. Automatic notifications appear when items will need to be removed from the
configuration in order to continue.
Added heavy duty hardware for the BEAM355 and BEAM355S (6500-MMK and 6500-SMK)
and the new CO Detector for ceiling mount applications (CO1224TR).
Added the ability to export the Bill of Materials to the Ecommerce template. You can use the
toolbar button located on the Bill of Materials page or use the File menu under Export ->
Program Information -> To Ecommerce.

Fixes




















Corrected a bug that would not allow you to edit Speaker/Strobe quantities, candela ratings,
and watt tap ratings inside of loaded save files.
Corrected a problem when launching new configurations from the Suppression tab on the
Lite-Configurator projects screen. For example, when selecting a MRP-2001 and clicking on
the Open button the program would launch a new MS-2 configuration. This has been
corrected.
Corrected a bug that was causing errors when printing data sheets from some Windows Vista
and Windows 7 machines.
Corrected a program crash that would happen when printing certain data sheets. An error
message would appear stating that there was an invalid property value and the program
would close.
Corrected the FM20.dll error that would occur on machines that did not have Office installed
on their system or had the 64-bit version of Microsoft Office installed.
Corrected the part numbers for E70-241575W-FR(FW) and ET70-241575W-FR(FW) in the
database.
Fixed a bug that was causing the format of the circuit grid to be incorrect when loading save
files. Loading save files will now reset the circuit grid to the default format.
Corrected a bug that would inadvertently add a HPP31076 Class A module when adding a
FCPS-24s6 or FCPS-24s8 and selecting 4 Class A circuits from the Circuit Configuration.
This has been corrected to add the ZNAC-4 module.
Fixed Total Alarm Load formula for the MS-9050UD Battery Calculation.
Moved battery calculation toolbar icon to the program interface. Battery calculations can now
be launched from the program interface by clicking on the battery icon labeled Battery
Calculations, the new icon appears after the Report icon.
Split TB1 Circuit Configuration for the MS-9200UDLS Rev.3 control panel to allow the user to
select either Resettable or Non-Resettable power from both pins 1, 2 and pins 3, 4.
Previously users were only allowed to configure pins 1, 2.
Intelligent NAC expander modules will now correctly add the appropriate number of NAC
circuits. Users will be able to choose how to power the devices and the additional NAC
circuits. This functionality has been added to the following parts, CMF-300 and CMF-300-6.
Intelligent IDC (2-wire) modules will now require users to set additional current draw from a
Non-Resettable Circuit. This will affect the following devices: MMF-302 and MMF-302-6.
The following devices and accessories will require the user to choose an additional circuit to
power these devices: BEAM-355S and B200SR.
Changed the top level description of the explorer section on the Configuration page to Circuit
Options followed by the Panel Name.
Discontinued the use of some of the single batteries in the database and replaced them with
the battery multi-packs. The following multi-pack batteries have been added to the database:
BAT-1270-BP, BAT-12120-BP, BAT-12180-BP, and BAT-12260-BP.
Adding single batteries will now add the appropriate number of back boxes if selected as an
accessory. For every two batteries that are added one back box will be added. For example if
four single batteries are added there will be two back boxes added to the configuration
Made upgrades to the Update.exe program.








Fixed a bug in which IT administrators could not install Lite-Configurator on a per-machine
basis. IT administrators should now be able to install Lite-Configurator under the
administrator account and have the program work for individual users.
Corrected a bug that caused the inability to add devices to the External Sources circuit that
had accessories (like detector bases) that had a current draw. The program would incorrectly
show an error stating that the current draw limit of the selected panel or power supply had
been reached. This has been corrected.
The default base for most intelligent detectors has been changed from the B350LP to the
new B210LP.
Added Montana (MT) to the state dropdown boxes on the Project Information page.
Corrected a bug that was not showing the Conventional Panel options when the Panel
Selection Wizard was selected from the Conventional or Suppression tabs on the LiteConfigurator Projects screen.

Version 2.3 (Web download) – January 4, 2011:




















Corrected a bug that would not correctly update the update.exe program.
Corrected a bug that would not subtract SLC counts from a loaded save file. When deleting
parts from a loaded save file the SLC counts of Detectors and Modules would not be
deducted from the total.
Added the ANN-SB80KIT-R(W) to the ANN-80(-W) for the MS-9200UDLS, MS-9600LS, and
MS-9600UDLS. This was inadvertently removed in the latest release.
Corrected the link to the CRF-300 data sheet. It was inadvertently pointing to the CMF-300
data sheet.
Fixed a bug in the Panel Selection Wizard that would inadvertently point users into a MS9600LS or MS-9600UDLS control panel when a smaller panel would be more appropriate.
Fixed the maximum NAC Power Needed in the Panel Selection Wizard from 8 amps to 7
amps.
Added a note to the Panel Selection Wizard for Intelligent Control Panels.
Reincluded the ANN-I/O LED as optional equipment for the ANN-I/O. This was inadvertently
removed in the latest release.
Added the MS-9200UDLS Rev.3 Intelligent Control Panel to the program. This has replaced
the Rev.2 version of this panel.
Maximum number of ANN-S/PG Interface Modules has been changed to 1.
Fixed a bug that would allow more than 8 ANN-BUS devices on ANN-BUS circuits. You are
now limited to a total of 8 ANN-BUS devices per ANN-BUS circuit.
Corrected the current draw for the SSM24-6, SSM24-8, and SSM24-10 bells.
Corrected the maximum NAC circuit power for the MS-10UD-7 battery calculation from 2.5
amps to 3.0 amps.
Corrected the maximum current draw in the MRP-2001 and MRP-2002 battery calculation
sheet.
Added Circuit Detail to all Control Panels, Power Supplies, and Voice Systems. Individual
devices on each NAC, Output, or Speaker circuit will be listed in a sub-report below the main
battery calculation sheet.
Fixed a bug that would cause intelligent devices added to non-SLC loops to not add their
current draw to the circuit. These devices will now properly add current draw to these circuits
when added, and remove that current draw when deleted.
Fixed some incorrect current draws and candela ratings that were being displayed for Strobe
devices.
Added the Auxiliary circuit to the FCPS-24Fs6 and FCPS-24Fs8 power supplies. Users will
now be able to configure the circuit as a Non-Resettable or Resettable power circuit (500 mA
max).
Added the HPFF8 and HPFF12 NAC Expander/Power Supplies to the program.





Added Main Circuit board current draw to all auxiliary power supplies when they are first
added to the configuration.
Added the ANN-MBRLY as an accessory to the ANN-RLY.
Added the following Secondary Alarm Times to all battery calculation sheets: 90 Minutes, 120
Minutes, 180 Minutes, and 240 Minutes.

Version 2.2 (Web download) – July 21, 2010:




















Added the MS-25 Intelligent Fire Alarm Control Panel.
Added HFS devices.
Corrected the current draw for the IPDACT-2 in the program and in the Battery Calculations.
Corrected the Total Alarm cell in the MS-10UD-7 Battery Calculation. Cell would incorrectly
turn red when the current draw was over 3 amps. This is corrected to 7 amps.
Corrected Battery Calculation sheets to include all ANN-BUS devices.
Corrected “File Not Found” error when updating Lite-Configurator using Microsoft Vista and
Windows 7.
Added the CH-6 Chassis to the database as an accessory to the BB-6F.
Added items to the database:
o Wheelock Exceder™ series horns, strobes, and horn/strobes.
o 5451 and 5451EIS series 400 conventional detectors
o 5601P heat detector
Circuit Grid no longer resets when adding, editing, or deleting parts. Circuit Grid would reset
every time changes were made to the grid, this will no longer happen and will keep its current
configuration when any parts are added, edited, or deleted.
Corrected a bug in the MS-9600LS and MS-9600UDLS battery calculation sheet that
generated an error and not inputting the current draw from NAC 4.
Updated the MS-5UD-3 and the MS-10UD-7 battery calculation sheets. The current draw for
the Main Circuit Board now includes 1 IDC Zone in alarm. The method for calculating the
alarm draw for conventional IDC circuits is changed. A line item is added to the battery
calculation sheet that will assign 40 mA per IDC circuit used minus 1 (minus 1 because 1 IDC
circuit draw is already accounted for in the Main Circuit Board Current draw). This is done to
match what the manual states.)
Marked several conventional initiating devices as Discontinued with notes on replacement
models. Note: You can find discontinued items at the bottom of the Conventional Initiating
devices list
Corrected the report so the store number no longer overlaps the PO Number. (Store number
is removed.)
When adding addressable initiating devices, the first SLC circuit now appears first in the
Circuit dropdown box on the Add screen. (Previously the first circuit in the dropdown would
be selected even if it was a non-SLC circuit.)
Added the ACC-25/50DA, ACC-25/50DAZS, ACC-25/50ZS, and ACC-25/50ZST to the MS9050UD Intelligent Control Panel.
Replaced the BG-TR optional trim ring for the BG-12LX with the BG12TR.
Corrected the image for the MMF-301 Mini-module.

Version 2.1.3 (online update – March 9, 2010): Corrected a bug that was not adding ANN-BUS
devices correctly to battery calculations.
Version 2.1.2 (online update – March 3, 2010): Corrected a bug in the MS-9600LS and MS9600UDLS battery calculations that was not adding a second SLC loop when adding a SLC-2LS.
Version 2.1.1 (online update – February 17, 2010):








Removed devices out of the database: AD350, D350PL, D350RPL, H350, H350R
Added error checking to the program to not allow both a CHG-75 and CHG-120F in a
configuration.
Removed B501BH-2 and B501BHT-2 Intelligent Bases from the program and replaced them
with the new B200SR Intelligent Sounder Base.
Corrected some battery calculation formulas for the MS-9600LS, MS-9600UDLS,
MS-9200UDLS Rev.2.
Added some error checking to the Audio Control Panels and Distributed Audio Panels.
Corrected a bug that was not displaying the different views for Suppression Panels on the
Lite-Configurator projects screen.

Version 2.1 (Web download) – December 18, 2009:
















Removed BAT-1250 5AH battery from the program.
Added the following parts to the database:
o D355PL, SW-ALERT, SWH-ALERT, SPSW-ALERT, MDL3R, MDL3W, PF24V, SWCLR-ALERT, SCW-CLR-ALERT, SPSCW-CLR-ALERT, CO1224T, 2151T, D2,
D4120, D4120W, and ROME.
Updated the Update program to version 2.0.
Updated Intelligent Control Panel Battery Calculation sheets to include the new D355PL duct
detector.
Placed a note on discontinued System Sensor Notification Appliances to direct users to use
the replacement model for that part.
Users with limited rights on their computer should now be able to use the program without
receiving file access errors.
Added a new update screen when the user first launches the program. This screen will
prompt the user to check for updates each time they start the program. This screen can be
disabled by checking the, “Do NOT show this screen on Startup” checkbox. Note: At any time
you can re-enable this screen under the options screen, update tab, and checking off “Show
Update Screen on Program Launch”.
Reorganized all parts on the configuration screen to place the older discontinued parts at the
end of the list of parts in each category. Newer parts will now appear at the top of the list.
Added Voice Panels: ACC-25/50ZST, ACC-25/50DA, and ACC-25/50DAZS
Removed parts and referenced updated parts:
o RA400Z -> Replaced with RA100Z
o RTS451 -> Replaced with RTS151
o RTS451KEY -> Replaced with RTS151KEY
Renamed the Accessories circuit to External Source to clarify that these parts are added to
the External Source circuit are not powered by the Control Panel or any additional Power
Supplies.
Four-Wire devices can be added to the newly renamed External Source circuit so you can
add 4-Wire devices and have them powered by an external source (such as HVAC unit).

Version 2.0.2 (online update – February 2, 2009): Added System Sensor Mini-Horns MHR and
MHW to the database.
Version 2.0.1 (Online Update – January 30, 2009): Corrected the current draw for the Main
Circuit Board for the MS-9200UDLS Rev.2 battery calculation and in the main database.
Version 2.0 (Web download – January 10, 2009):



Changed the limit on the FCPS-24FS6 and FCPS-24FS8 so more then 10 power supplies
can be added to a control panel.
Update program has been improved.








Added the MS-9600LS and MS-9600UDLS to the program. Removed the outdated MS-9600
control panel. For ADT the Unimode 9600 has been replaced with the Unimode 9600UDLS.
Updated the MS-9200UDLS control panel to the new MS-9200UDLS Rev.2 control panel.
The new version of the panel adds ANN-BUS devices.
Added the ANN-BUS circuit to the program. Only ANN-BUS devices will be allowed to be
placed on this circuit.
Added the following parts to the database:
o ANN-RLED
o XRM-24B – New transformer for the MS-9200UDLS Rev.2
o B501BH-2 (replaces B501BH)
o B501BHT-2 (replaces B501BHT)
o SLC-2LS (replaces SLC-2)
o IPDACT-2, IPDACT-2UD (replaces IPDACT)
New logos for battery calculations (Fire-Lite Only).

Version 1.2 (Web download – September 26, 2008):



















Added Gentex and Wheelock devices to the database
Fixed a bug that was causing the program to crash when certain speakers or speaker/strobes
were being chosen.
Updated the Candela control to include a new candela setting that is used in Gentex
notification appliances.
Fixed a typo in the database for the BEAMHKR, it was inadvertently listed as BEAMHRK.
Fixed a bug that was causing the program to lock up when attempting to print pdf files with
Acrobat Reader 8.0.
Fixed a bug that was not showing Conventional Initiating Devices that require a base
selection to be made before adding it to the configuration. While these parts could be seen
when showing all Conventional Initiating Devices they were not shown when selecting
individual types (like Photoelectric and Ionization).
Removed Relay Modules from Conventional Initiating Device section and placed them under
accessories.
Fixed a bug that was causing users to not be able to add dry-contact conventional initiating
devices for intelligent panels when the appropriate module was installed.
Fixed a bug that was not renumbering circuits correctly when deleting power supplies or
voice systems.
IDC circuits will now be added when adding the following modules to an Intelligent Control
Panel:
o IDC circuit (2-Wire) - MMF-302, MMF-302-6
o IDC circuit (4-Wire/Dry Contact) – MMF-300, MMF-300-10, MMF-301
When choosing a conventional panel the description on the Configuration page above the
parts tree was mislabeled saying “Intelligent Control Panel”. This has been fixed.
Added the following parts to the database
o ANN-80-W, ANN-SB80KIT-R, ANN-SB80KIT-W
Added the ability to add a PO Number to the project information and to the report.
New ADT logo added to the report and the battery calculation sheets (ADT Only).
Added two releasing panels to the program. The MRP-2001 and MRP-2002 (Firelite Only).
Added 90 hour alarm time requirement for all of the battery calculations.

Version 1.1.1c (online update – June 12, 2008):


Fixed a bug inside the MS-9600 battery calculation that was not telling the user to add a
charger when one was required. Also fixed a bug inside the MS-9600 battery calculation
that was not telling the user to order additional back boxes when they were needed.



Fixed a bug in the MS-9600 battery calculation that was causing an error when
attempting to add Notification Appliances located on the NAC 4 circuit.

Version 1.1.1b (online update – May 13, 2008):



Corrected the B224BI intelligent isolator base to take up one address on an SLC loop.
Corrected the B224RB intelligent relay base to take up zero addresses on an SLC loop.

Version 1.1.1a (online update – May 12, 2008):





Added new System Sensor Speakers and Speaker/Strobes to the Database. The
following parts have been added:
o SPSW, SPSR, SPSWH, SPSRH, SPSWV, SPSRV, SPSCW, SPSRW,
SPSCWH, SPSCRH, SPSCWV, SPSCRV, SPSCWVH, SPSCRVH, SPSWK,
SPSRK, SPSCWK, SPSCRK
Fixed the current draw for the EOLR-1 inside the Battery Calculation sheets. The value
was changed too 20mA in all instances.
Fixed a bug that was causing improper watt tap information to be displayed when users
were editing speaker/strobes.

Version 1.1.1 (Web download – March 13, 2008): Corrected a problem with the help file not
being able to be found inside the program.
Version 1.1 (Web download – February 29, 2008):













Added the ability to add a custom graphic to the header of the report. Users can add a
new graphic by going to the Tools menu and selecting Options.
Fixed the link to the 5600 series conventional heat detector data sheet. The data sheet
was inadvertently put in the database as DF-52400 this was changed to DF_52400. Also
corrected the link to the SD355 data sheet.
Added an Accessories circuit to every control panel. Use the Accessories circuit to place
items that are not drawing power from the control panel or an auxiliary power supply.
o Example: Place door holders that are being powered by external AC in the
Accessories circuit area so they are not counted inside the battery calculations.
Added the category of CO detectors under the Conventional Initiating Devices. Also
added the CO1224 carbon monoxide detector to the database for this new category.
The LCD-80F is now limited to 32.
Swapped some of the categories on the configuration tree. This was done to make them
more in the order a person would build a system. Changes to the order are as follows:
o Addressable Initiating Devices
o Conventional Initiating Devices
o Notification Appliances (moved below initiating devices)
o Auxiliary Power Supplies (swapped with voice systems)
o Voice Systems
Fixed a bug that was causing parts that were placed in the Miscellaneous Device section
of the battery calculations to have larger than normal current draw values. Instead of
individual current draws multiplied by the quantity of the device the total current was
being multiplied by the quantity leading to huge current draws.
Fixed a bug that was causing high quantity values to crash the program when adding and
editing devices. The maximum number of devices has now been limited to 9999.
Added the following parts to the database:

o
o




















PAM-1, PAM-2, PAM-4
FM980, FM996, FM998 (with the following accessories: FM900, FM900-Z,
FM900-50, FM900-75, FM900-100)
o MR-101/T, MR-101/C, MR-104/T, MR-104/C, MR-201/T, MR-201/C, MR-204/T,
MR-204/C, MR-199X-13, MR-199X-13C, MR-199X-14, and MR-199X-14C
o PR-1, PR-2, PR-3, EOLR-1, R-10T, R-14T, R-20T, R-24T, R-10E, R-14E, R-20E,
and R-24E
o ANN-LED, ANN-RLY
o 411, 411UD (Accessories: PRO-411, MCBL-7)
o IPDACT (Accessories: IPBRKT, IPENC, HP300ULX, ALMSC120)
o CAC-4, CAC-5X
Added an image for the PRN-6F Printer.
Added a Note field to the configuration page to give more information about some of the
parts.
Added 4 new Conventional Control Panels to the program:
o MS-2
o MS-4
o MS-5UD-3
o MS-10UD-7
Fixed a bug that was causing Auxiliary power supplies and voice systems to be added to
the battery calculation sheets. These devices will no longer appear in any battery
calculation as they have their own AC and batteries.
Added an export feature for Microsoft Access. Users can now export Bill of Materials and
Project Information to an Access database.
Fixed a bug in the ADT version of the program inside the Panel Selection Wizard. The
program would crash when selecting certain panels. This has been fixed.
Changed the way Conventional devices are added to the circuit grid. Conventional
devices will now go in their correct location, 2-wire devices, pull stations, tamper switches
will now go only on IDC circuits. 4-Wire devices will have to be hooked to Resettable
power.
Fixed the external power supply battery calculation sheets to be clearer.
Adding an ANN-S/PG will now add an EIA-232 circuit to the circuit grid so you will be able
to add a printer.
Fixed a bug in the program that was not adding current draw to battery calculation sheets
when multiple power supplies are used.
Double-Clicking on parts on the configuration screen will now bring up the Add screen.
The Bill of Materials screen has been enhanced. Users will now be able to print individual
data sheets, view individual data sheets, or print all selected data sheets.
o Data sheets that are printed will be downloaded into the new Documents folder
before they are printed.
Fixed the links to the following data sheets: LCD-80F, D350PL/D350RPL, H355R, MMF302-6, 1424, 2151, BG-12 series pull stations, DH100ACDCI, DH100ACDCP, FCPS24FS-6(8), ACC-25/50ZS, and BAT Series Batteries.
Error checking added for Intelligent Panels when adding Conventional Devices. You will
now be required to add the appropriate module before adding 2-wire and 4-wire devices.
The Add dialog box on the configuration screen will now appear at the cursor, instead of
some predetermined location.

Version 1.0.1 (Web download – July 12, 2007):




Corrected the MS-9600 battery calculation sheet. Several areas incorrectly referred to the
panel as the MS-9600LS.
Updated descriptions for the New Configuration screen.
Updated the New Configuration screen to have larger buttons.

























Added the RTS451, RTS451KEY, and the RA400Z as accessories to the appropriate
parts.
Fixed a bug that allowed accessories to be added to parts with a quantity of 0 when
editing a part.
Fixed a bug that inadvertently selected a MS-9050UD control panel when selecting
between 51-198 points in the Panel Selection Wizard.
Corrected the improper labeling of the CMF-300-6 in the database; it was incorrectly
listed as the MMF-300-6.
Added the BB-2F and the BB-6F back boxes for Multi-Modules to the database.
Fixed a bug in the update program that caused the program to stay in memory when it
should have closed. This condition was caused when the update program was unable to
find an internet connection.
The SLC information section that lists counts for Detectors and Modules has been
updated. “Dev” and “Mod” labels have been replaced by “Detectors” and “Modules”.
Added a note to the I300 Fault Isolator Module to remind users that this device takes the
current of 2 addressable devices.
Fixed a bug with the scroll bars in the Optional Equipment section of the configuration
screen. In some instances optional equipment would not be selectable.
Separated Addressable and Conventional Initiating Devices on the configuration screen
to limit confusion.
Corrected a bug that was not allowing users to add the maximum number of Addressable
Initiating devices to an SLC loop. Users will no longer receive an error message when the
total current of all devices reaches 400mA on a SLC loop. Current on a SLC loop will be
maximized to 400mA to match battery calculations and no further error messages will
appear about current draw on an SLC loop. Error messages will only appear when the
limitations of Detectors and Modules are exceeded on an SLC.
Fixed a bug that caused the program to crash when attempting to delete a part with a
quantity over 32,767.
Added optional second SLC maximum alarm draw for addressable devices for the MS9600 battery calculation.
Fixed a bug that would keep the SLC-2 detector and module counts visible when starting
nd
a non-two loop panel after having an MS-9600 panel loaded that had the optional 2 loop
loaded.
Fixed a bug in the MS-9600 configuration when a user deleted the SLC-2. Users would
still have the second SLC loop as a choice to add devices, even though it was removed
from the circuit grid.
Fixed a bug that was not adding up the same part on different SLC loops inside the
battery calculation sheet. Instead of adding these parts together the quantities would just
overwrite each other only showing the total of what is on SLC 2.
Added Trim Rings and Dress Panels for all control panels to the database.
Added the PRN-6F and the PRT/PK-CABLE to the database. This can be found under
the new category of Accessories on the Configuration screen.
Added a feature that keeps track of past save files so that they can be opened easily.
Just go to the “Existing” tab inside the Lite-Configurator projects screen. The last 10
saved projects will be displayed.
Double-Clicking on save files will now open that save file inside the program.
Fixed a bug that caused the battery calculations to crash if the user had the default
number of starting sheets in Excel set to anything other than 3 sheets.
Added Supervisory, Pressure, and Tamper switches to the database. These devices can
be found under the new category under Conventional Initiating Devices called “Switches”.

Version 1.0 (Web download – June 1, 2007):


Fixed a bug that caused the Excel battery calculation sheet for the MS-9600 to crash






when launched.
Corrected a bug that caused the program to crash when attempting to delete a power
source that had an accessory.
Added an Internet Update feature to the program. Users will now be able to receive
updates over the internet by using the Update Program. Users can run the update
program alone through the Start menu shortcut or though the program under the Help
menu by selecting “Check for Updates”.
Corrected several graphic files included with the program. Some of the graphics were not
appearing transparent.

